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PURPOSE STATEMENT

This document provides an overview of features and enhancements included in release 14.12.0.0.0.

DISCLAIMER

This document in any form, software or printed matter, contains proprietary information that is the exclusive
property of Oracle. Your access to and use of this confidential material is subject to the terms and conditions of
your Oracle software license and service agreement, which has been executed and with which you agree to
comply. This document and information contained herein may not be disclosed, copied, reproduced or
distributed to anyone outside Oracle without prior written consent of Oracle. This document is not part of your
license agreement, nor can it be incorporated into any contractual agreement with Oracle or its subsidiaries or
affiliates.

This document is for informational purposes only and is intended solely to assist you in planning for the
implementation and upgrade of the product features described. It is not a commitment to deliver any material,
code, or functionality, and should not be relied upon in making purchasing decisions. The development, release,
and timing of any features or functionality described in this document remains at the sole discretion of Oracle.

Due to the nature of the product architecture, it may not be possible to safely include all features described in
this document without risking significant destabilization of the code.

DISCLAIMERS FOR PRE-RELEASE, PRE-GA PRODUCTS

The revenue recognition disclaimer on this page is required for any white paper that addresses future
functionality or for products that are not yet generally available (GA). If you are unsure whether your statement
of direction needs the disclaimer, read the revenue recognition policy. If you have further questions about your
content and the disclaimer requirements, e-mail REVREC US@oracle.com. If you do not need the disclaimer,
you may delete it and the page that it appears. First, display hidden characters by clicking on the Paragraph
icon on the Home toolbar. It is a small, square icon that appears to the left of the Quick Style Gallery. Then,
highlight all the text on this page and press the Delete key. Notice that there is a section break displayed as a
double-dotted line at the bottom of this page. Continue to press Delete until the page disappears and your
cursor is on the Table of Contents page. Be sure not to remove the section break, or the formatting of the title
page will be incorrect. Delete this note before publishing.

The testing disclaimer in the TM block on the last page (highlighted in yellow) is provided by the FCC for
hardware products. It must appear in the TM block for all pre-release, pre-GA hardware products. Be sure to
remove the yellow highlighting before publishing. When the product becomes GA, update your collateral by
removing the disclaimer from the TM block. If your product is already GA or if you are writing about a software
product, delete the disclaimer from the TM block.

Important: If your product is not GA, then you cannot include any regulatory compliance information in the
statement of direction. Regulatory compliance information may be included for GA products only if you have
completed all required safety and emissions testing, and you have received the certificates issued by the testing
organization.
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INTRODUCTION

As organizations transition from on-premises solutions to cloud-based platforms, it is essential to recognize the implications this shift
has on various processes and functionalities. This is to explores the significant changes accompanying this migration, particularly in the
area of file handling. One of the crucial processes impacted is the upload and download of files, which will undergo notable
enhancements to leverage the cloud's capabilities.

In a cloud environment, file upload and download processes are optimized for better performance, scalability, and security. Unlike
traditional on-premises systems, the cloud allows for more flexible and efficient data management strategies. This whitepaper outlines
how these process changes can enhance user experience, streamline operations, and improve overall system efficiency. By
understanding these transformations, organizations can effectively plan their transition and harness the full potential of the Oracle
Financial Services Lending and Leasing Cloud solutions.

OVERVIEW

File upload process

If the user wants to feed the external files into the system, the method is to use the APIs. Using this, users can upload the files into the
system, and those can be processed by the existing batch jobs.

PREREQUISITE:

1. The Webservice deployment was done in the same instance, and it should be up and running.
o Validate the Swagger Documentation end point of that instance, annotation of the URL: https://<host>/OfslIRestWS/
Example: https://demo.ofsllcs.ocs.oraclecloud.com/OfslIRestWS.

2. Token Based Authentication is enabled for a User Code.
CONFIGURATION:

1. Setthe CMN_DEPLOYMENT_TYPE - DEPLOYMENT TYPE CODE either CFS or GBUCS.

System Parameters
Important: This is a one-time setup before starting to use the product. You must only change configuration values once you know the impact of the system. It will help ensure that the system |
system,

View » Format v .‘ Freeze ﬁ' Detach cﬂWrap Gﬁ

& %DEPL%
Parameter Parameter Description Parameter Value
CMN_DEPLOYMENT_TYPE DEPLOYMENT TYPE CODH ON-PREMISE

System Parameters

ESM

Parameter CMN_DEPLOYMENT_TYPE = Enabled
Parameter Description DEPLOYMENT TYPE CODE Enter the value for the system parameter
* Parameter value CF5 b
GBUCS

ON-PREMISE

2. Make sure the following set of system parameters values as Y and Enabled.

PARAMETER PARAMETER DESCRIPTION

CMN_AUD_FILE_PROCESS_TO_LOB CHANGE AUDIT SCRIPT INCOMING/OUTGOING FILE PROCESS TO CLOB PROCESS
CMN_DOC_PROCESS_TO_LOB APPLICATION AND ACCOUNT DOCUMENT FILE STORAGE TO BLOB(YES)/ BFILE(NO)
CMN_EDF_FILE_PROCESS_TO_LOB CHANGE DIALER INTERFACE INCOMING/OUTGOING FILE PROCESS TO CLOB PROCESS

CMN_FAX_FILE_PROCESS_TO_LOB CHANGE FAX INCOMING/OUTGOING FILE PROCESS TO CLOB PROCESS
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PARAMETER PARAMETER DESCRIPTION

CMN_FILE_PROCESS_TO_LOB CHANGE INCOMING/OUTGOING FILE PROCESS TO CLOB PROCESS

CMN_LBT_FILE_PROCESS_TO_LOB CHANGE LOCK BOX INCOMING/OUTGOING FILE PROCESS TO CLOB PROCESS

CMN_ODD_FILE_PROCESS_TO_LOB CHANGE OUTPUT DATA DUMP INCOMING/OUTGOING FILE PROCESS TO CLOB PROCESS

CMN_RED_FILE_PROCESS_TO_LOB
CMN_SED_FILE_PROCESS_TO_LOB

CMN_WFP_FILE_PROCESS_TO_LOB

CHANGE DATA MASKING POLICY INCOMING/OUTGOING FILE PROCESS TO CLOB PROCESS
CHANGE SEED DATA INCOMING/OUTGOING FILE PROCESS TO CLOB PROCESS

CHANGE WFP UNIT INCOMING/OUTGOING FILE PROCESS TO CLOB PROCESS

Provide an access to the below webservices Access Codes from Ul - Setup - Administrator > User - Access =
Webservices > Setup = Security User Access Definition Details.

FLL.INCOMINGFILERESOURCE.POST.INCOMINGFILE ACCESS TO INCOMING FILE SERVICE

3.

ACCESS TO INCOMING FILE SERVICE ACCESS TO OUTGOING FILE SERVICE

ACCESS TO OUTGOING FILE SERVICE ACCESS TO OUTGOING FILE LIST SERVICE

Mumber Generation % = Access x [3¢] Close
Data Screen Reports  Correspondence  Transaction  Webservice
Security Super Group View || < Audit
View ~ Format = Freeze ﬁd‘ Detach cﬂ Wrap E‘ﬁ
& SETUP
Super Group
[ seTwP
Security Access Definition # Edit view || < Audit
View » Format + Freeze ﬁd‘ Detach qﬂ Wrap E‘ﬁ
() Yes
& %FILE% Oho
Access Code Description Type System Defined Enabled
. FLL.INCOMINGFILERESOQURCE.POST.INCOMINGFILE ACCESS TO INCOMING FILE SERVICE WEB SERVICES Yes No Y
FLL.OUTGOINGFILERESOURCE.GET.GETOUTGOINGFILE ACCESS TO QUTGOING FILE SERVICE WEB SERVICES Yes Mo Y
FLL.OUTGOINGFILERESOURCE. GET.GETOUTGOINGFILELIST ACCESS TO OUTGOING FILE LIST SERVICE WEB SERVICES Yes No Y
4 >
[ Security User Access Definition Details o add | 7 Edit View || < Audit
View ~ Format = % Freeze ;j;f Detach qﬂ Wrap E‘ﬁ
Access Type Access Value Allowed System Defined

.RESPDNS]BILTY ALL Yes  No Yes Mo

5

Enable the ‘Incoming Log File Type Codes’ lookup codes for the required files [INCOMING_FILE_TYPE_CD]. If user wants to
upload the files for a specific company, create a new lookup code as <file type>/<company code>
Example: ITU/SKO1

4.
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Lookup Code Description
Tuy USER UPLOAD
ITU/SKD1 TRANSATION UPLOAD FOR SKD1
IPC/SKO1 CUSTOMER BASED PAYMENT UPLOAD FOR SKO1
ITU/HKGO1 TRANSACTION UPLOAD FOR HKGD1
IPU/SKDL PAYMENT UPLOAD FOR SKO1
ICA CALL ACTIVITY POSTING ON ACCOUNT
IFD LIEN TRACKING PROCESSING
Imu TRANSACTION UPLOAD
EDF AUTO DIALER RESPONSE DATA LOAD
LBX LOCKBOX
.. ]

5. Prepare the endpoint URL with the above host as follows; this service is used to Upload the Files to the system.
https://<host>//OfslIRestW S/service/api/resources/setup/incomingfile
Example: https://demo.ofslics.ocs.oraclecloud.com/OfslIRestWS/service/api/resources/setup/incomingfile.

file = actual file that to be uploaded

fileType = should only has three-character
P —— ‘Incoming Log File Type Codes’ Example: IPU

usercode = send this value to validate against
DR D R L= A= LS the Access Setup and Audit purpose
ptccompany = send this value, if the file to be
processed by company base batch job, else,
system will process by ‘ALL’ company job.

Parameters

Name Description

file * reauired Stores upload/ Incoming File Contents

file
No file chosen

(fornData) Header Parameter:

fileType Process type
string flType - Process type Content-Type = multipart/form-data

(formData)

omingfile
usercode Standard who
string example - USR123 Headers | 3
tossnate) usercode - Standard who<i> example : USR123</i>

+ Add i Delet=all & Description

ptccompany Company
string
(formbata)

Accept
ptccompany - Company

Host ated at runtimes>

Content-Type multipart/form-data

Example:

/api/resources/ p/incomir > 201 Created 93 ms

Preview

@ Deleteall © Description S
« 1

"14.12 CAC Env Account Payment Filele.txt”,

§ 14.12 CAC Env Account Payment File10.txt € : "IPU",

e Hil- 1 €
fileType IPU oming File Uplo successfully™

usercode RBOINA

ptccompany CAC1
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6. Once the file is uploaded, this can be seen from the Ul = Dashboard - Processed Files = Incoming Processed File >
Uploaded Files.

Uploaded Files

View v Format» ({58 Freeze G: Detach ol Wrap ) ViewLast @ 1Day (02 Days (05 Days (O All Days
é mmdd/yyyy E})
File Mame File Type File Dt Status
. 14.12 CAC Env Account Payment Filel0.bd PAYMENT UPLOAD FOR CAC COMP... 06/20/2025 06:53:59 PM UPLOADED
14.12 CAC Env Account Payment File9. bt PAYMENT UPLOAD FOR CAC COMP... 06/20/2025 06:49:21 PM UPLOADED

7. Run the associated job from the SET-IFP to get it processed.
8. Access the log files from the ‘Uploaded Files’.

5 Days () All Days @ Download File Data L?; Download Bad Data L:; Download Log Data

Status Error Reason User
UPLOADED BARAK BO
UPLOADED BARAK BO

Access outgoing files

If the user wants to access the system generated outgoing files, to read the files data.

=  For GBUCS = use the APlIs.
=  For CFS = Use Ul or APlIs.

PREREQUISITE:

= Make sure, the ‘Setup - System - Data Files - Outgoing Files’ seed data loaded and enabled.

Process Files %  Data Files x
Output  Input
Data File Definitions
View » Format [ Freeze i Detach | <J Wirap 0]
¢l )
Name Description File Name
ACC_DETAILS ACCOUNT DETAILS accdetails_§(COMPANY_CODE)_$(PROCESS_DATE_MMDDYYYY_HHMISS)
ADVERSE_ACTION ADVERSE ACTION LETTER adverse_action
ADVERSE_ACTION_CONDITIONAL ADVERSE ACTION CONDITIONAL LETTER adverse_action_conditional
AUTO_DIALER_EXTRACT QUTBOUND DIALER EXTRACTION TOQ DIALER SYSTEM auto_dialer_extract_$(PROCESS_DATE_YYYYMMDD).dat
BKRP_INTERFACE LN BKRP INTERFACE Lnx_bkrp_output_$(COMPANY_CODE)_${PROCESS_DATE_YYYYMMDD_HHMISS).spr
CBU_UTL4_DOWNLOAD MONTHLY HANDSOFF FILE FOR SIMAH chu_utl4_download.csv
COL_LETTER_1 COLLECTION LETTER 1 col_letter_1
COL_LETTER_2 COLLECTION LETTER 2 col_letter_2
COL_LETTER_3 COLLECTION LETTER 3 col_letter_3
COUPON_BOOK COUPON BOOK ORDER coupon_book

= User should create the accounts and run the dependent jobs under SET-TPE, SET-ODD2, and SET-ODD3 etc., at a set
frequency as per the functionality to generate the outgoing files.
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Ul APPROACH:

1. Access Ul > Dashboard - Processed Files - Outgoing Process File - Outgoing Process File.
2. Select the required file and click on ‘Download’, the file downloaded directly to the local machine.

Incoming Process File  Outgoing Process File
Qutgoing Process File
View v Format + @ Freeze [A!Detach ¢l Wrap B2 [B Download Viewlast (1 Day (O 2Days O) 5 Days @ All Days Company  ALL v
& mmiddfyyyy B
select All [ File Name File Type File Date File Size(bytes) Status
| master_account_customer_mock_stmt_20200127.dat OUT PUT DATA FILE 06/18/2025 07:40:40.. 2332 GENERATED
O master_account_customer_mock_stmt_20200127.dat QUT PUT DATA FILE 06/18/2025 07:40:38. 4447 GENERATED
D master_account_customer_mock_stmt_20200127.dat QUT PUT DATA FILE 06/18/2025 06:24:41... 1578315 GENERATED
O master_account_customer_mock_stmt_20200127.dat QUT PUT DATA FILE 06/18/2025 06:24:40... 1650321 GENERATED
D master_account_customer_mock_stmt_20200527.dat OUT PUT DATA FILE 06/18/2025 04:31:22... 77125 GENERATED
D master_account_customer_mock_stmt_20200527.dat OUT PUT DATA FILE 06/18/2025 04:31:22.. 83541 GENERATED
D master_account_customer_mock_stmt_20200427.dat QUT PUT DATA FILE 06/18/2025 12:45:54... 1180 GENERATED
O master_account_customer_mock_stmt_20200427.dat QUT PUT DATA FILE 06/18/2025 12:45:52... B6AY GENERATED
D master_account_customer_mock_stmt_20200327.dat OUT PUT DATA FILE 06/17/2025 06:56:37... 1180 GENERATED
O master_account_customer_mock_stmt_20200327.dat QUT PUT DATA FILE 06/17/2025 06:56:36... 8661 GENERATED
History
View v Formatw  [5p Freeze i Detach »
User Download Dt
. BARAK BOTNA BOINA 06/20/2025 07:44:35 PM

TWO STEP API APPROACH:
Step 1: Use ‘list the files’ API to get the File ID.

1. Prepare the endpoint URL with the above host as follows: this service is used to list the system generated output files for a
given File Name.
https://<host>//OfslIRestWS/service/api/resources/setup/outgoingfile
Example: https://demo.ofsllcs.ocs.oraclecloud.com/OfslIRestW S/service/api/resources/setup/outgoingfile

fileName: This should be same as
Setup = System - Data Files >
; Outgoing Files - Data File Definitions
Isetup/outgoingfile " »
- “Name
This service is used o list outgoing process file details fromDate: Starting date (inClUSion) from
which the files are needed.
toDate: ending date (inclusion) form
which the files are needed.

Parameters

Name Description

fileName * r=avired Stores the Output Data File Definition Name Header Parameter:
string example : customer_ach

(query) fileName - Stores the Qutput Data File Definition Nam

Content-Type: application/x-www-form-

fromDate * =avir=d Date range considered for analysis ( Lower Limit ). ur|encoded
example : 2017-12-01

string($date)
(query) fromDate - Date range considered for analysis ( Lower

Headers [ 3
toDate * =aui=d Date range considered for analysis ( Upper Limit )
string($date) example : 2017-12-01

(query) toDate - Date range considered for analysis { Upper Li
<calculated at runtime>

applicatio n-urler
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Example:
GET w [ 200 OK 175 ms
REELE :I Scripts  Docs Preview H
+ Add i Delete all © Description
Accept
Host <calculated at runtime> ! ATEMENT",

i Content-Type application/x-www-form-urlencoded

622351,
"master_acc e mt_2e288427 .dat”,

mt_2@8200427 .dat",

mt_2@8200527 .dat",

Step 2: Use the ‘File Download’ service to download the file data.

1. Prepare the endpoint URL with the above host as follows: this service is used to download the system generated output file
data for the given File ID.
https://<host>//OfslIRestW S/service/api/resources/setup/outgoingfile/{fileid}
Example: https://demo.ofslics.ocs.oraclecloud.com/OfslIRestW S/service/api/resources/setup/outgoingfile/622351

Jsetup/outgoingfile/ffileid)

This service is used to download specific system generated outgoing files

fileid: the file id which is received as
part of the step 1 to be provided in the
input.

Parameters

Name W ptccompany: Company code that
fileid = r=air=d Reference to Outgoing Process File Id. belongs to the file.

example - 1001

integer

(path) fileid - Reference to Outgoing Process File 1d.<i> exan

ptccompany company

string
ptccompany - company
(query)

Example:
rl}} /setupfoutgoingfile/622351?ptccompany=CAC1

Params

Query Params

Key 1 RECO|04/27/2620|HKGBR | HKGE1 |
REC6|331518| 416898 | |N] CURRENT_ACCOUNT [N|N| | VEHICLE|CAR| ||| [NIN| |||
ptccompany RECO |84 /27 /2020 | HKGBR | HKGE1 |
REC6 |331518| 416898 | |N] CURRENT_ACCOUNT [N|N| | VEHICLE|CAR| ||| [NIN| |||
RECO | 84/27 /2620 | HKGBR | HKGE1 |

518|416@98| |N| CURRENT_ACCOUNT [N |N| | VEHICLE|CAR| || [ ININ]|]]
2028 | HKGBR | HKGE1 |
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